
Trac Software Manual 
 

Juliet E. Carroll  
New York State IPM Program 

 
 
 
 
 
 
 
 
 

Financial Support Provided by 
 

The New York State Department of Agriculture and Markets 
The New York Wine and Grape Foundation 

Constellation Wines U.S. 
The New York Agriculture Innovation Center 

New York Farm Viability Institute 
The New York State Turfgrass Association 

 
 

© 2003-2014 Cornell University. All rights reserved. 
 

 



Trac Software Manual  
written by Juliet E. Carroll 
New York State Integrated Pest Management Program 
Cornell Cooperative Extension 
2011 

 
Trac Software (copyright 2003-2011 Cornell University) is Excel-based 
record-keeping and reporting software.  

 
Trac software is available for fruit crops: 

 
TracApple © 2003-2014 Cornell University 

 
TracPear © 2005-2014 Cornell University 

 
TracStoneFruit © 2005-2014 Cornell University 
 (peach & nectarine, apricot, plum) 

 
TracCherry © 2005-2014 Cornell University 
 (sweet & tart cherry) 

 
TracGrape © 2004-2014 Cornell University  

 
TracBerry © 2005-2014 Cornell University 
 (strawberry, blueberry, raspberry & blackberry, currant & gooseberry) 

 
 
Trac software is available for turfgrass: 

 
TracSod © 2008-2014 Cornell University 

 
TracGolf © 2008-2014 Cornell University 

 
TracGrounds © 2008-2014 Cornell University 

 
TracLawn © 2008-2014 Cornell University 

 
 
Trac Tech Support 
Frequently Asked Questions http://nysipm.cornell.edu/trac/tracfaqs/  
More information on Trac software http://nysipm.cornell.edu/trac/ 

http://nysipm.cornell.edu/trac/tracfaqs/
http://nysipm.cornell.edu/trac/
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ENABLING VISUAL BASIC MACROS 

TRAC SOFTWARE WILL NOT WORK IF VISUAL BASIC MACROS ARE DISABLED 
Make certain the macros are enabled in your Trac Software. If prompted, enable the 
macros. DO NOT disable the macros. Macros are programming code for Trac software. 
They are written in Visual Basic for Applications (VBA) in Microsoft Excel. 
Excel versions: 

Microsoft Windows 
.xls Excel 97 (version 8.0) included in Office 97 (for x86 and Alpha) 
.xls Excel 2000 (version 9.0) included in Office 2000 
.xls Excel 2002 (version 10) included in Office XP 
.xls Office Excel 2003 (version 11) included in Office 2003 
.xlsm Office Excel 2007 (version 12) included in Office 2007 
.xlsm Excel 2010 (version 14) included in Office 2010 

Apple Macintosh 
.xls Excel 8.0 (part of Office 98) 
.xls Excel 9.0 (part of Office 2001) 
.xls Excel 10.0 (part of Office v. X) 
.xls Excel 11.0 (part of Office 2004) 
Excel 12.0 (part of Office 2008) – Visual Basic not included 
.xlsm Excel 14.0 (part of Office 2011) – Visual Basic back in 
 
ENABLE THE MACROS: 
For PC’s  

Excel 1997-2003  
Excel security level may be set at High by default and macros will be disabled. Reduce 
the security level in Excel from the Tools menu; under Tools, select Macro, then 
Security and then set the Security level to Medium.  Open Trac. In the dialog box stating 
the file contains macros by Cornell University, check the box next to “Always trust 
macros from this publisher.” and click on the “Enable Macros” button.   

Excel 2007 and 2010  
If a yellow Security Alert message appears under the Office Ribbon stating that macros 
have been disabled, click on   Enable Content  . You can access more information 
about macro settings from the File tab.  Click on the File tab and click on “Options” 
under Help. Select “Trust Center”, then “Trust Center Settings…” and then “Macro 
Settings” to see how your version of Excel is set up to handle macros. 
 
For Macintosh computers  
A dialog box may appear.  If so, select “Enable Macros”. 
 

Note: Computer operating systems, Microsoft Excel versions and 
networks may vary in how they handle VBA macros.   

 

Trac Software will not work in the Excel version 
12.0 (part of Macintosh Office 2008) because it 
doesn’t contain VBA. 

.xls Trac*_v2011compat.xls software works in these Excel versions. 

.xlsm Trac* v2011.xlsm software works in these Excel versions. 
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OPENING TRAC AND SAVING FILES 

OPENING AND SAVING TRAC FOR THE FIRST TIME 
Note: Excel VBA macros, and therefore Trac Software, will not 
work in Mac Office 2008 on Macintosh computers. 
 

Open the Trac Software file and save it to a new name and location on your computer.  
 

1. Double click on the Trac Excel workbook icon to open the file. 
 
2. A dialog box may appear warning you that the file contains macros published by 

Cornell University. See page 4 on Enabling Macros. 
 
3. Click on File in the main menu of Excel and select Save As. 
 
4. In the Save As window, in the box next to “Save in:” select a location where you 

want to save your file, such as Desktop or My Documents.  
Note: Remember this file location for easy access to update your 
spray data records. 

 
5. The box next to “File name:” will show the name of the Trac software program. 

Replace this file name with a new file name of your choice. Choose a meaningful, 
easily remembered name.  Ex.) TracSprays09 

Note: Do not save your files with the same filename as the Trac 
software program. 

 
6. Click on the Save button, to the right of the box showing the file name, to save 

your Trac spray record workbook file to your computer. 
 
 
BACKING UP TRAC 
The original Trac software file you obtain provides a permanent backup copy of the 
blank software. Always maintain backup copies of your file(s) on CD, zip disk, external 
drive, another computer, etc. 
 

Note: Once you start entering data, save your file frequently to 
protect your data. And backup your files. 

 

   Page 5 



NYS IPM, Carroll Trac Software Manual 
 

 
UPDATING TRAC FROM THE PREVIOUS YEAR  
To update NameAddress, Applicator, SiteLists (previously called FarmData), and 
ChemTable from the previous year’s Trac files to the current year – Copy and Paste it. 
 
You can transfer one year’s farm/business information to the next year’s Trac software 
file. 
NameAddress information, Applicator information, lists on the SiteLists sheet and 
ChemTable materials can be copied from last year’s file(s) and pasted into the new Trac 
software file(s). The example below is for the SiteLists (FarmData in previous years’ 
versions) sheet. 
 

1. Open your new Trac file and click on the SiteLists tab to open the desired sheet. 
 
2. Open last year’s Trac file and click on the SiteLists tab to open the same sheet. 
 
3. Copy data from one column at a time. That is, do column B only, etc. 
 
4. Within a column (ex. column B), click on your first entry below the heading (ex. 

Farms) in that column and drag the mouse down to select all the entries in that 
column. 

 
5. On the main menu click on Edit, then Copy; on the home ribbon click on Copy. 
 
6. Go to your new Trac file and click on the first cell directly beneath the column B 

heading (ex. Farms). 
 
7. On the main menu click on Edit, then Paste; on the home ribbon click on Paste. 

The list will paste in. 
 
8. Continue doing this for the remaining information you want to transfer until all are 

copied and pasted from the old file to the new file. 
 
9. After copying and pasting into your new Trac file, the lists can be edited or added 

to, if needed. 
 

 
Note: Once you start entering data, save your file frequently to 
protect your data. 
 
Note: Trac versions change year-to-year, so be careful when 
copying and pasting data as column arrangements may have 
changed.  
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EXCEL SHORTCUTS 

Excel contains several features that help enter or select data quickly and efficiently. 
Below are a few suggestions. 
 
Select a 
range of cells 

Click on the corner cell in the range to be selected, scroll to the opposite 
corner and hold the Shift key down while clicking on the cell in the 
opposite corner to select the range. 

Fill in with 
“Ctrl D” 

Enter data in a cell. Select that cell and the cells below where the same 
data is to be copied. Press and hold the Ctrl key down while pressing D. 
Cells fill with the same data. 

Fill in with 
“Ctrl Enter” 

To enter the same data in several cells, select all the cells first. Type 
your data in the first cell (it will not be highlighted). Press and hold the 
Ctrl key while pressing Enter. Cells fill with the same data. 

Drag to 
AutoFill 

Fills cells with the same or sequential information. Select cell with data, 
place cursor on the lower right hand corner of the cell until the black 
cross appears (the fill handle), click, hold, drag and let go.  Cells will fill 
with same or sequential information. 

Undo with 
“Ctrl Z” 

If an error is made or something unwanted was done, “undo” it. Press 
and hold the Ctrl key down while pressing Z.  

AutoComplete Excel automatically inserts data in a cell that begins the same as a 
previous entry in the column. Example: If “Sunny and calm” has been 
typed in a cell, Excel will complete “Sunny and calm” as soon as you 
begin to type this in the next cell in that column. Press Enter to accept 
the AutoComplete word(s). 

Help in Excel Access it by clicking on Help on the main menu. 
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TRAC TIPS 

Some helpful tips on using Trac software. 
 
Do not delete! Never delete entire cells, rows, or columns because this will cause 

permanent damage to the software. If possible, immediately “undo” the 
deletion with Ctrl Z or “Undo” in the Edit menu. See Trac Tip below. 

Clear contents, 
don’t delete. 

Deleting physically removes the cell, row, or column causing 
permanent damage to the software. Trac sheets are protected to 
prevent this from happening. The delete key on the keyboard is 
probably the best way to clear contents (you can also right click on the 
cell or cells you want to clear and click on “clear content”). 

Light-blue cells Don’t clear contents of the light-blue-shaded cells. Clear contents of 
the white cells and all the related entries in the light-blue-shaded cells 
also clear. 

Comment 
boxes 

Read helpful tips in comment boxes by moving the cursor over the red 
triangle in the top right corner of some of the Trac column heading 
cells. 

Drop-down lists Access drop-down lists by clicking on the down arrow located directly 
to the right of the cell. Click on desired item in the list to select and 
enter. 

Type in a cell 
with drop-down 
list 

Type data into a cell with a drop-down list if the drop-down list does 
not contain the information you need. 

Faster data 
entry – tank 
mixes 

To make data entry easier (for such things as tank mixes or harvested 
blocks), or to repeat large sets of data, use Excel’s fill in shortcuts as 
described under Excel Shortcuts, page 7. Don’t copy and paste data in 
the light-blue cells. 

Unprotect 
sheets 

Data entry sheets (NameAddress, Customers, SiteLists, ChemTable, 
ChemHelp, SprayData, FertData, HarvestData) are protected to limit 
what can be done to them. These sheets can be unprotected. Protect 
the sheet again, after Unprotect, to prevent inadvertent damage to the 
Trac software sheet. See the top two Trac Tips. 

Password 
Protect 

Report sheets and the Central Posting Form sheet are password 
protected and cannot be unprotected. 

EPA WPS 
Central Posting 
Form 

When applying a tank mix on the same day, the re-entry time and date 
for each material in the mix will be calculated and displayed on the 
EPA Central Posting Form sheet. To Print: Select the rows you want to 
print, and hit the Print Button. The latest REI among the selected 
applications will calculate and post in a box at top of form. 
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SETTING UP YOUR INFORMATION IN TRAC 

Deciding how to set up your business’ information is an important first step. Because 
the software is essentially an Excel spreadsheet file, you can create one single master 
file for the entire operation and later copy/paste parts of this file into other files.  
 
There is no right or wrong way to record your information in Trac. Although, how you set 
it up can help streamline future use of the recorded data. 
 
Your business’ information is entered on the following data entry sheets: 

NameAddress 
Applicators (2005 and later versions, changed name entry in 2008/2009) 
SiteLists (FarmData on prior years’ versions) 
Customers (TracLawn only) 
ChemTable (2011 and later versions, see pages 12-13) 

 
For optimum utility, enter name, address, applicator, customer, site and chemical 
information before starting to enter spray information. The ChemTable is where you 
enter the list of chemical materials used on your farm (see pages 12-13).  
 
The sheets SprayData, FertData and HarvestData have drop-down lists derived from 
the information entered on the SiteLists, Customer, and ChemTable sheets. Selecting 
from a drop-down list streamlines data entry, insures consistent use of names in your 
records, reduces typographical errors, and enhances accurate sorting and filtering of 
your spray records. 
 
These data entry sheets are protected. This limits what can be done to them and 
protects their formatting. You can unprotect the NameAddress, Applicator, SiteLists 
Customers, ChemTable and ChemHelp sheets in the Tools menu or Review ribbon. 
Always turn protection back on if you unprotect a sheet.  
 
 
NAME-ADDRESS SHEET 
Enter on this sheet your name, business name, address and contact information. Where 
applicable, a table of the processor/buyer reports that can be generated is included. 
Next to the listed processors/buyers, enter your grower number (if you have one). 
Information from this sheet is automatically sent to the report forms. 
 
 
APPLICATORS SHEET (2005 and later versions) 
Enter on this sheet the names, pesticide certification ID numbers and expiration dates 
for the persons who apply pesticides on your farm or for your business. Also list the 
spray application and spreader equipment here. These data become drop-down lists on 
the record-keeping sheets and some reports. 
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SITE-LISTS SHEET (previously called FarmData; not included in TracLawn) 
 

Note: Each column is simply a list of names or codes. 
 

List on SiteLists the names or codes for:  
Column B - farm(s); course(s); property type(s)   
Column D - orchard(s); vineyard(s); field(s); golf feature(s); property name(s) 
Column F - block(s); hole code#(s); section/area(s) 
Column G - size(s) in acres; size(s) in 1000 sq ft units 
Column I - variety(s); grasses/mixtures  
 

Note: Only columns F and G must be entered side-by-side. The 
size of the area treated (Column G) will fill in automatically when 
the block, hole code#, or section/area name (Column F) is selected 
on SprayData and FertData. 

 
These lists will automatically become the drop-down lists on the SprayData, FertData, 
HarvestData, and some of the reports. Create your lists in a way that will make data 
entry easier and more consistent. 
 
In Column B of TracGrounds there is a drop-down list of property types already 
included. If your property type is not found in the software list, type it into the cell in 
column B.  

In Column F of TracGrounds, enter a specific area name such as “Johnson 
baseball field” or “east campus lawn”.   
 
In Column D of TracGolf there is a drop-down list of golf features to choose from. Type 
in additional features if needed.  
 
In Column F of TracGolf there is a drop-down list for hole code #’s that already uses the 
word “All” to designate common management units such as “All tees”. For golf, choose 
from the drop down list or code a common treatment group, as described below under 
“Consider how your sprays are applied”. 
 
In Column I there is a drop-down list of Variety names, or Grasses / Mixtures names  
already included from which to choose to make data entry easier. Type in names which 
do not appear in the list. 
 
When creating the lists in SiteLists, consider how to best set up your records to 
generate the reports you need.  Some considerations: 

How do you apply sprays?   …fertilizers? 
Is the entire orchard, vineyard, field, property  sprayed at once, or in sections? 
How are your orchards, vineyards, fields, courses divided? 
What are your typical “management” units or sections? 
How many varieties are you growing? 
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Do you market certain varieties or blocks to specific processors or buyers? 
What Trac reports are most important to your operation? 
 

Using words in your list like “All” or “Every” can streamline record-keeping for sprays or 
fertilizers that are applied on the entire farm or on all varieties. 
 
Consider not using columns which do not apply to your business structure, keeping in 
mind the utility of linkage between columns F & G. Use this linkage to your record-
keeping advantage. 
 
Consider how you need to track your blocks. For the list of Block names or codes, the 
size of the block is entered next to the block name. Use abbreviated names or codes if 
necessary. Put unique identifying characters at the front of the name when names are 
similar. For example, if several blocks contain Concord grapes, they might be 
designated as “B-l Concord” and “B-2 Concord”, etc. 
 
Consider how your sprays are applied. Are all the Concord grape blocks sprayed on a 
single day or does it take longer? Are only the Ginger Gold apples sprayed for fire 
blight? Are all golf greens treated together? In each of the lists (columns B, D, F, or I) 
you may want to have the word “All” to easily indicate that all in the category were 
treated on the same date and time.  

Also consider if groups within a location are usually treated together; for 
example, if four golf course tees are commonly treated at the same time, code them 
together as “T1,4,5 &11” in column F. 
 
Consider how your harvest operation proceeds. Will it be useful to have split-block 
designations so drop-down lists in the HarvestData sheet improve your record keeping? 
 
If you have a small farm business, leave columns blank that do not apply to your 
business structure. It is recommended to list even a single name. The drop-down lists 
streamline data entry, insure consistent use of names in your records, reduce 
typographical errors, and enhance accurate sorting and filtering of your spray records. 
 

Note: (2008 and later versions) Add more rows to the SiteLists 
sheet with the “Click Here For More Rows” button.  

 
 
CUSTOMERS SHEET (TracLawn only) 
Enter on this sheet the Customer name, street address, city (town, village, municipality), 
state, zip code, county, and the number of 1000 sq ft units for the entire size of the 
customer’s lawn. 
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CHEM-TABLE SHEET 

The ChemTable sheet (2011 version) is filled in by you, in designated areas, by entering 
the chemical materials used on your farm. A sample ChemTable list (from 2010) is 
included on the ChemHelp sheet as a guide to help you in entering your chemical 
product information. Changes in pesticide registrations, regulations, and use guidelines 
frequently occur. The sample pesticide list included on the ChemHelp sheet was 
created in 2010 and is provided for guidance only; it is not intended to be used as a 
substitute for pesticide label information. You can also enter the cost of the applied unit 
of each material as you are entering the other information. 
 
After entering your chemicals, you can filter the list to reduce the length of the drop 
down list on SprayData.  For instance, to only show the materials in a tank mix applied 
repeatedly at several sites; or to show only restricted use materials for filling in the 
Restricted Pesticides Purchased report. The filter can be turned on, turned off, modified, 
etc. and will prove very useful in record-keeping. 
 

 Always Read Your Product Label  
 
Enter your chemicals. Avoid leaving any blank rows, so make sure to start at the top, 
either row 4 or 5. You can overwrite the example in row 4 once you gain confidence. 
The list does not need to be in alphabetical order (if you need it alphabetized, “Sort” it in 
Excel, see pages 22-23). Enter all the chemicals that are used in your operation.   
 
It is not necessary to enter all chemicals before starting SprayData records. Just make 
sure the chemicals you will record applications for on SprayData are on the ChemTable 
and therefore in the SprayData drop down list. Add to the ChemTable at any time. 
 
For optimum software performance, enter all the information for each product, including:  

Trade name 
Formulation 
EPA registration number 
Active ingredient (common name) 
REI (in hours) 

PHI (in days) 
Type of material 
% Active ingredient 
Company 
Labeled Crop abbrev. 

 
Note: Products with identical trade names (i.e. identical text) will 
not display in the SprayData drop down list, so change one slightly. 

 
Note: For products with zero restricted entry and preharvest 
interval (REI and PHI) times, type in Zero Hours and Zero Days, 
respectively. 

 
You can copy and paste from the sample 2010 ChemTable on ChemHelp, if you have 
verified that the pesticide information matches the label for the pesticide(s) you have 
used and what’s been applied.  You may also be able to copy and paste from prior Trac 
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Software files (for instance, chemical information from the yellow rows in versions 2006-
2010). Do not use drag and drop, cut, or delete to move information from another 
location into the Trac ChemTable. 
 
There are 300 rows on the ChemTable.  If you need more rows, highlight the last, 
empty, formatted row to select all the formatted cells in that row. Place the cursor over 
the bottom right corner of the last, right-hand cell until the + cross-hairs appear. Click 
and drag down to add the number of rows needed.  
 
Enter your chemical costs. In columns C & D, enter the cost per unit of the chemicals 
used and the units applied (ex. lbs). When this information is entered, the cost of each 
spray application will automatically calculate and fill in on the SprayData sheet. 
 
From Trac version 2008 on, the unit applied must be entered on the ChemTable and will 
fill in automatically on SprayData. This prevents errors in cost calculations. 
 

Always Read Your Product Label 
 
Filter the chemicals you use (2006 and later versions). To customize the list of 
chemicals being recorded in Trac sheets, enter an “x” or “word of your choice” next to 
their trade names in column A on the ChemTable sheet. Click on the Filter button, in cell 
A3 at the top of the column, and select “x” or “word of your choice” to show the 
customized list on the ChemTable. This shortens the SprayData drop-down list of Trade 
Names, too. To show all chemicals again, Filter for “All” or “Select All”.  
 

 
 
 

Note: Once you start entering data, save your file frequently to 
protect your data.  

 
This software and any information contained herein is not a substitute for pesticide 
labeling. Verify all information on the label for the product(s) you use. Always read the 
label before applying any pesticide. 

The Filter Button, a small square 
with a down arrow triangle, is 
found under the “Custom Chem 
List” heading  
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KEEPING RECORDS IN TRAC 

Records are kept on the SprayData, FertData, and HarvestData sheets. Drop down lists 
are generated from the Applicators, SiteLists, Customers and ChemTable sheets. 
 
When entering data use Fill shortcuts to save time and to repeat large sets of data such 
as dates, tank mixes or harvested blocks. See Excel Shortcuts on page 7. 

Note: You can type into cells containing drop down lists. 
 
You can use columns to the right of the formatted areas on these sheets to enter 
customized information (details of weather, sprayer calibration, nozzles fitted, etc.)  
 
PROTECTING YOUR SOFTWARE 
Data entry sheets are protected. This limits what can be done to the sheets to protect 
their formatting. You can unprotect the SprayData, FertData, HarvestData and 
ChemTable sheets in the Excel Tools menu or in the Review ribbon. Always turn 
protection back on if you unprotect a sheet. 
 
Never delete or cut entire cells, rows, or columns because this will cause permanent 
damage to the software. Deleting physically removes the cell, row, or column from the 
software. Trac sheets are protected to prevent deleting. Clear contents, don’t delete. In 
Excel, the delete key on the keyboard clears contents and is probably the easiest way 
to clear contents (you can also right click on the cell or cells you want to clear and click 
on “Clear contents”).  
 
Light-blue shaded columns contain formulas. Don’t clear contents of the light-blue-
shaded cells. Clear contents of the white cells and all the related entries in the light-
blue-shaded cells also clear. If data is cleared from light blue cells, formulas that 
automatically fill the cells also clear. To refill the formulas in the light blue cells do the 
following: 

1. Click on an empty, unused cell in the appropriate (same) column. 
2. Copy it. (Click on Edit then Copy in the main menu; click on Copy in the Home 

ribbon). 
3. Select the cell that is not filling in and click on Paste from the main menu or home 

ribbon. 
 
 
SPRAY-DATA SHEET 
This is where the spray information is entered. Information on this form is automatically 
sent to the EPA WPS Central Posting Form, where applicable. 

Note: (2006 and later versions) Add more rows to the SprayData 
sheets and associated reports with the “Click Here For More Rows” 
button. 
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You select the report to send spray data to (2006 and later versions). Column A allows 
you to select from a drop-down list the report form (or Every Report) that you want to 
send the data to. The row can be sent to one report and later sent to another, as 
needed, for your reporting purposes.  
 
Printing reports made easy (2006 and later versions). Blank rows will appear on the 
report forms. Filter them out with the pre-set filter buttons. Just click on the filter button 
and select “Non Blanks” to filter out the empty rows from the print-out. And print the 
report. To show all the data again, click on the same filter button and select “All”. 
 

 
 
Light blue shaded columns contain formulas and will fill in automatically. If data is 
cleared out of cells in columns shaded light blue, formulas will also clear. Simply copy 
an empty cell in the same column and paste into the cleared cell to refill the formulas 
functions, see page 14. 
 
Earliest Harvestable Date will not calculate unless the Date Spray Applied and PHI 
information are correct and in the proper date and number formats, respectively. 
 
Total Cost will not calculate unless the cost per applied unit is entered on the 
ChemTable as described on pages 12-13. 
 
It is not necessary to enter sprays on a block-by-block basis unless it fits your reporting 
or record keeping needs. To enter a spray for an entire farm or course or property, all 
orchards or vineyards or fields or features, all blocks or hole #, or all varieties, etc. 
include a word such as “All” or “Entire” in the lists on the SiteLists sheet, see pages 10-
11. When all orchards or vineyards or fields or features, all blocks or holes, or all 

Filter Buttons, small squares with 
down arrow triangles, are found 
in each heading. Use any one to 
filter for “Non Blanks” or un-click 
“Blanks” to remove blank rows 
before printing.  
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varieties are sprayed on the same date and time, simply choose the word “All” from the 
drop-down list in that column on the SprayData sheet. 
 
Make sure your reporting requirements continue to be met when using this tactic. While 
this tactic may reduce data entry, it may preclude accurate reporting and the ability to 
organize spray information at the orchard, vineyard, feature, variety, section or block 
level. 
 
Time start spray and time finish spray. Trac will automatically change time entries to 24-
hour format. Trac will accept either 12-hour or 24-hour time entries in the proper format.  
Time Start Spray and Time Finish Spray must be entered in the proper format for the 
program to calculate time-dependent entries, such as the Earliest Harvestable Date on 
the SprayData sheet and the Safe Re-entry Time on the WPS Central Posting Form. 

Note: Access the Comment Box, move the cursor over the red 
triangle in the top right corner of the Time Start Spray or Time 
Finish Spray cell to see time entry examples. 

 
Target Pest. Determine the single primary pest that you are targeting the pesticide 
against and select it from the drop-down list. Alternatively, more than one target pest 
can be entered but not by selecting them from the drop-down list. To enter more than 
one target pest, type the information in directly. Use abbreviations to shorten the list to 
make it easier to read or increase column width to allow room for more entries.  
 
To increase column width: 

1. Click on Excel Tools then Protection then Unprotect sheet, or on Review then 
Unprotect.  

2. Place the cursor over the right-hand border at the top of the Target Pest column 
until the black cross with arrows appears, click, hold and drag to the right to the 
size desired and let go.  

3. Protect the sheet when done.  
Whenever increasing a column width realize that the sheet may print to more pages 
horizontally. To check and adjust this if needed, use Print Preview or Page Setup. 
 
 
TANK MIXES 
Each chemical in the tank mix goes in a separate row on the SprayData sheet because 
the EPA registration number, REI, PHI, etc. are specific to each chemical. A lot of other 
information (Date Spray Applied, Block(s), Variety Sprayed, etc.) will be the same on 
each row of the tank mix.  Use Excel Fill shortcuts, page 7, to fill in this information, 
quickly and easily. Two examples are given below. 
 
Tank Mix Example 1 – New Tank Mix 
 

1. Enter the complete first row of data for one material in the tank mix.  
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2. Then, for the other materials, enter Target Pest, Decision Support, Pesticide 
Trade Name, Amount (Rate) per Acre or 1000 sq ft, Number of Acres or 1000 sq 
ft units Treated, and Units in the appropriate columns.  Check the information in 
the light blue colored cells for accuracy. 

 
3. Fill all other cells from the first row with Ctrl-D, Copy/Paste or Ctrl-Autofill: 
 

Ctrl-D 
• Select the cell(s) to be copied and the empty target cells to be filled in, and 
press Ctrl-D. 
 
Copy/Paste 
• Select the cell(s) to be copied, in first row of tank mix. 
• Click on Edit then Copy on the Excel menu bar or Copy on the Home ribbon. 
• Select the cells to copy the information into. 
• Click on Edit then Paste on the menu bar and hit OK, or Paste on the Home 
ribbon, to paste the copied data into the cells. 
 
Ctrl-Autofill 
• Select the cell(s) to be copied, in first row of tank mix. 
• Position the cursor on the lower right corner of the selected cell(s) until the 
cursor turns into a + crosshairs. 
• With + crosshairs showing, click and hold mouse button while depressing the 
Ctrl key and drag the crosshair down to the last row of tank mix to be filled in. 
• Release mouse and then release the Ctrl key. Copied information will 
populate cells. 
 

Note: If using Autofill without using the Ctrl key, Excel may 
sequentially “auto-number” the entries. Check to insure this does 
not occur. 

 
Tank Mix Example 2 – Repeatedly Used Tank Mix 
 
A tank mix used repeatedly, on different locations or at different times of the year, once 
entered, can be copied and pasted. 
 
If just the chemicals in the tank mix are the same: 
 

• Select the Pesticide Trade Name cells containing the chemicals in the mix. 
• Click on Edit then Copy on the Excel main menu, or Copy on the Home 
ribbon. 
• Click on the topmost cell in the Pesticide Trade Name column where you 
want to paste the copied tank mix list. 
• Click on Paste to paste in the tank mix. 
• Follow the instructions in Example 1 above to fill in the rest of the information. 
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Alternatively, you can copy and paste the entire set of SprayData information for the 
tank mix, from the Date Spray Applied column to the Comments column: 
 

• Select the entire set of data by clicking on one corner cell and then holding 
the Shift key down while clicking on the opposite corner cell. 
• Click on Edit then Copy on the Excel main menu, or Copy on the Home 
ribbon. 
• Click on the top left cell of the location where you need to put the data set. 
• Click on Paste to paste just the copied data into the cells without overwriting 
any formulas. 
• Then in the top row change any information that is not correct, such as Date 
Spray Applied, Weather Conditions, etc., and copy into the other rows as 
described in Example 1 above. 

 
Manage your tank mix records with any combination of copying, pasting and filling sets 
of data using the methods described. 
 
 
FERT-DATA SHEET 
This sheet is a record of fertilizer applications, based on the fertilization records required 
for Globalgap certification. Drop down lists are generated from the SiteLists or 
Customers sheets. 

Note: (2006 and later versions) Add more rows to the FertData 
sheet with the “Click Here For More Rows” button. 
 

 
HARVEST-DATA SHEET 
On this sheet keep track of bloom or planting dates and harvest dates. In the Tracking 
Number column, enter the unique number (invoice number, weigh ticket number, etc.) 
that allows trace-back of the harvested crop from the buyer/shipper/storage. In 2005 
and later versions, additional columns are formatted for customized farm information. 

Note: (2008 and later versions) Add more rows to the HarvestData 
sheet with the “Click Here For More Rows” button.  

 
 
HIDDEN ROWS 
A hidden row in the SprayData, FertData, HarvestData, and SiteLists sheets is copied to 
create new rows using the “Click Here For More Rows” buttons. Do not Unhide this row. 
Do not enter data into it. If you Unhide it, re-Hide it and keep it hidden so data is not 
entered into it. 
 
If you enter data into it by mistake, the new added rows will contain this data. Unhide 
the last row. Clear the contents from the white cells in these new rows and hide the 
bottom row again. 
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CREATING REPORTS IN TRAC 

The report forms in Trac software are password protected and cannot be changed by 
the user. Cells that require data entry by the user can be typed into. The report form 
sheets available in Trac software programs include the following: 

EPA WPS Central Posting Form 
Beechnut 
BirdsEye&Others 
CarriageHouse 
Constellation 
Cliffstar&WestfieldMaid 
EcoApple 
GLOBALGAP 
GenericForm 

GrowersCo-Op 
Knouse 
Meier’s 
MogenDavid 
Motts&YonderDistr. 
PrivAppRecord 
ApplicatorReport-26 
Applicators-26A 
RecordKeeping-26 

 
Not all report forms are in every Trac software program.  

Note: Access the Comment Box on some report forms, move the 
cursor over the red triangle to obtain information on which 
companies accept that form. 

 
 
EPA WPS CENTRAL POSTING FORM 
This form fills out automatically from the Spray Data sheet.  
  To print: 

2006 and later versions 
1. Select (highlight) the rows you want to print. 
2. Click on the “Print” button. The latest REI among the selected applications will 

calculate and post in box at top of form. 
 
Troubleshooting. Empty Safe Re-entry Date or Safe Re-entry Time indicate that data for 
the pesticide application on the SprayData sheet is either missing or in an incorrect 
format. Check each of the items outlined below, make corrections as required, and then 
see if the change corrected the problem on the Central Posting Form. If the REI is still 
missing simply type the appropriate REI from the pesticide label into the SprayData cell. 
 

On the SprayData sheet check: 
 
Date Spray Applied – a date must be entered. 
 
Time Finish Spray – a time must be entered and must be in the correct format. 
See page 16 under “Time start spray and time finish spray” or access the 
Comment Box in the Time Finish Spray cell. 
 
REI – REI must be a number in hours. If the REI has words, other than Zero 
hours, in addition to a number, the Safe Re-Entry date and time will not calculate. 
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There are chemicals for which the REI may vary depending on its usage or as 
described on the pesticide label. Therefore, you must determine the appropriate 
REI for the pesticide based on your use pattern and the pesticide label. Simply 
enter the appropriate value in the SprayData REI cell. To do this you may need 
to unprotect the SprayData sheet, see page 16. 
 
REI cell may be empty because the formula that looks up the REI was 
inadvertently deleted from the SprayData cell. To re-enter the formula, copy an 
empty, unused cell in the SprayData REI column and paste it into the empty REI 
cell where the formula was deleted, see page 14. 
 
On the ChemTable sheet check: 
 
REI for all the user-defined chemicals (yellow rows, bottom of list) must be 
entered. If any are missing, enter them as per the pesticide label. Always enter 
the REI in units of hours, unless 0, then enter Zero hours. 

 
 
PRINTING REPORTS 
See page 15 under “Printing reports made easy” for how to send SprayData to the 
report you choose and to use the pre-set Filter arrows to remove blank rows and then 
print. To show all the data again, click on the same filter arrow and choose “All” or 
“Select All”. 
 
 
CREATE REPORT FILES TO SUBMIT ELECTRONICALLY 
There are a number of ways that this can be accomplished. One way is described here. 
To create a copy of a single report form in another workbook file, follow the steps below: 
 

1. Using the Filter arrow button on one of the columns on the desired report form, 
filter the report to show only the data you will need to send to the processor. 

2. Click on Edit, or click on the sheet tab, and select Move or Copy Sheet. 
3. In the Move or Copy Sheet window, in the box under “To book:” select “new 

book” from the drop-down list. 
4. Click the box next to “Create a copy” to make sure the report remains in your 

Trac software file while a copy is created in the new book.  
5. Press OK. A copy of the report form appears on screen in a new book, usually 

with filename Book 1. 
6. Save the new file with a new file name (ex. ConstellationConcordReport09). 
7. Open your email program. Create an email message and attach the appropriate 

report file. How you do this will vary depending on your Internet service provider, 
email program, computer hardware and the software configuration. 
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WORKING WITH DATA 

Data can be re-organized or rearranged on Trac’s data entry sheets. Use Excel’s 
Data/Filter or Data/Sort features to re-organize data in the SprayData, FertData, and 
HarvestData sheets. Unprotect the sheets before beginning and protect them again 
after finishing. All automatically filled report sheets are password protected and cannot 
be sorted, but some can be filtered using pre-set Autofilter arrows. 

 
Note: Before performing data manipulations always save the file. 

 
 
FILTER DATA 
Filter data on a sheet, for example, by a particular variety and only the data on that 
particular variety will show. Filter is a safe feature to use because it does not rearrange 
the file’s data and can be turned on and off. See additional information on Filtering Data 
in Excel’s Help. 
 
Print Filtered sheets. When printing directly from a filtered sheet, only the displayed, 
filtered data is printed. To narrow down what is printed, you can “Hide” columns (click 
on Format, then Columns, then Hide, or on Home ribbon, Format, then Hide or Unhide). 
This allows you to generate customized reports for specific reporting needs. Click on 
File then Print from the main menu and hit OK. If desired, click on the Preview button to 
verify what will print before clicking on Print.  
 

Why Filter Data? 
• Customize the ChemTable so the trade name drop down list only shows 

organic materials for easier SprayData entry for organic blocks. 
• Show the sprays applied to a single variety on the SprayData sheet. 
• Group the cost of spray applications on a single block for the entire 

season on the SprayData sheet. Then select the Total Cost column and 
Excel automatically sums and displays the overall cost in status bar at 
the bottom of the Excel window. 

• Determine the acres and varieties of grapes harvested on a certain day 
on the HarvestData sheet. 

• Display spray data entries by Target Pest and then by a location on the 
SprayData sheet to check the use of different chemistries or modes of 
action to prevent pest resistance. 

 
Filter by following the steps below: 

1. Click on Tools in the main menu bar, then on Protection, or click on the Review 
ribbon, then on Unprotect Sheet to unprotect the sheet. 

2. Select any single cell containing data. 
3. Click on Data, then Filter, then AutoFilter. Arrows appear in each data heading 

cell. 
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4. Click on the arrow button in the column containing the information you want to 
filter and select the item to filter for from the filter selections. 

 
The sheet now shows just the entries for that item. To filter further, select items from the 
drop-down lists on other columns. To show all the data again, click on Data, then Filter, 
then Show All on the main menu. 
 
To turn Filter off: 

1. Click on Data, then Filter. 
2. Click on the checkmark next to AutoFilter. The arrows will disappear from the 

data heading cells. 
 
When you are done filtering and all the data is showing, protect the sheet again, 
Tools/Protection/Protect Sheet or Review/Protect Sheet (without a password) to prevent 
inadvertent damage to the Trac software sheet. 
 
 
SORT DATA 
To organize data on a sheet, Sort it by information in chosen column(s). Data can be 
sorted alphabetically or numerically in ascending or descending order. Data is 
permanently rearranged when sorted. See additional information on Sorting Data in 
Excel’s Help. 
 
When selecting data to sort on SprayData, FertData, or HarvestData, make certain that 
the entire data set is selected to prevent disassociating the information in columns from 
that in rows. In Trac, the automatically-filled report sheets will sort in the same manner 
as the SprayData sheet is sorted.  
 

Why Sort Data? 
• Organize sprays chronologically by Date Spray Applied on the SprayData 

sheet. This may be particularly helpful if a spray was entered out of 
chronological order. 

• Organize sprays by location, by Farm and then by Orchard or Vineyard or 
Field and then by Block, on the SprayData sheet. This may be particularly 
helpful to group sprays by the location applied. 

• Organize spray data entries by Pesticide Trade Name and then by Farm 
on the SprayData sheet. The seasonal cost of each pesticide on each 
farm can then be viewed, as follows. Select the Total Cost column entries 
for a particular pesticide used on a farm and Excel automatically sums and 
displays the overall cost in the status bar at the bottom of the Excel 
window. 

• Organize alphabetically the Varieties list column on the SiteLists sheet to 
make the drop down list on the data entry sheets easier to scan. 

 
Applicators sheet. The lists of responsible persons and pesticide applicators on the 
Applicators sheet can be sorted, for instance, by the expiration date of their pesticide 
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applicator certification license. Or it might prove easiest to scan lists of names that are 
in alphabetical order.  
 
SiteLists sheet. It may prove useful to sort the SiteLists information in alphabetical order 
to make the drop down lists easier to scan. When sorting the lists on the SiteLists sheet, 
the Blocks and Acres columns must be sorted together. All others must be sorted one 
column of data at a time. 
 
Print Sorted Sheets. Sorting data can facilitate selecting a particular range of data for 
printing. To do this, select the rows that contain the data you want to print and print the 
“Selection”. 

1. Select (highlight) the rows you want to print. 
2. Click on File then Print… and under Print what, choose Selection and then click 

OK. You can also choose Print Selection in the Print Preview window.  
 
Sort Data by following the steps below: 
Before sorting large sets of data (SprayData, FertData, or HarvestData sheets) save the 
file with a different file name and sort only in this file. 
 

1. Open your farm’s Trac file. 
2. Click on File, then Save As on the main menu. 
3. In the Save As window, enter a new file name (ex. TracSpraysSort) and hit Save.  

 
The file just saved is now the open file. Proceed to Sort Data.  
 
Note: In large data sets, never sort just one column of data because this will alter the 
relationship of the data in that column with the rest of the data in the rows. If possible, 
undo: click on Edit then Undo, OR press and hold the Ctrl key and press Z. If you can’t 
undo, close the file without saving it and re-open it. 
 

1. Open the sheet to be sorted by clicking on the sheet tab. 
2. On the main menu click on Tools, then Protection, then Unprotect Sheet, or on 

the Review ribbon click on Unprotect Sheet to unprotect the sheet. 
3. Click on any single cell containing data or in the colored row of data headings. 
4. Click on Data then Sort. 
5. The entire range of data will be selected and a Sort window will open. 
6. Follow the directions in the Sort window. 

 
The range of data will be sorted as chosen. All the rows in the processor reports will be 
sorted in the same manner as in the SprayData sheet. Data can be sorted again, or 
other files created for different sorting operations. 
 
When you are done sorting, protect the sheet again, as described above, (without a 
password) to prevent inadvertent damage to the Trac software sheet.  
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